This Read Me documents important compatibility information and known issues for the following:

- Pro Tools 9.0.6 and Pro Tools HD 9.0.6 software with supported hardware on qualified computers running Mac OS X 10.6.x (“Snow Leopard”)
- Pro Tools 9.0.6 and Pro Tools HD 9.0.6 software on computers running Mac OS X 10.7.x (“Lion”)

This release includes previous updates from Pro Tools 9.0.5, 9.0.4, 9.0.3, 9.0.2, and 9.0.1.

**Compatibility**

Avid can only assure compatibility and provide support for qualified hardware and software configurations.

💡 For the latest compatibility information—including qualified computers, operating systems, and third-party products—visit the Avid website (www.avid.com/compatibility).

**All Pro Tools Systems**

An iLok must be connected at all times while running Pro Tools.

Pro Tools requires that an iLok with the appropriate authorizations be connected to the computer at all times. Do not remove the iLok while running Pro Tools 9.0.5. If the iLok is removed while Pro Tools is running, one of the following will occur:

Pro Tools shows a dialog giving you the following choices:
- Reinsert the iLok and click Save. Pro Tools saves the session and then quits.
- Click Quit. Pro Tools closes the session without saving and then quits.

– or –

Pro Tools displays a dialog giving you the following choices:
- Reinsert the iLok and click OK to continue working in Pro Tools.
- Click Cancel. Pro Tools closes the session without saving and then quits.

Pro Tools cannot record to drives formatted as Case-Sensitive. (PTSW-64502)

Pro Tools cannot record to Mac OS X drives which have been formatted as “Case-Sensitive.” Format the Mac OS X record volumes as “Mac OS X Extended (Journaled)” in order to record properly.

**Spotlight indexing can interfere with long record passes. (97151)**

There are known incompatibilities with Spotlight indexing drives while recording audio. If you will be recording to a large number of tracks for over an hour, set all of your drives to private in the Mac OS X System Preferences to ensure maximum performance. Failure to do this may result in Pro Tools reporting an error and ending the record pass when Spotlight indexes the drives.
Pro Tools menus and interface are grayed out on launch. (PTSW-18024)

Pro Tools can appear unresponsive at launch, with the Menus grayed out and browsers inoperable. This can happen because of Spaces. If Pro Tools is launched in any other Space than the first one, the Session Quick Start dialog still opens in the first Space. You can temporarily disable Spaces, launch Pro Tools, and disable the Session Quick Start dialog in the Preferences to avoid this problem.

Automatic Update Notification will not connect through a proxy server that requires authentication. (108837)

Software Updater will not find an active internet connection when behind a proxy server that requires authentication to gain internet access. To work around this, the client machine with Software Updater needs to be moved out from behind the proxy or the proxy needs to allow HTTP access via port 80 without requiring authentication.

Ethernet control surfaces and work surfaces may be unable to communicate with Pro Tools when Parallels Desktop for Mac is installed. (101232)

If you use an Ethernet control surface (such as C|24) or work surface (such as D-Control or D-Command) with Pro Tools, Parallels Desktop for Mac may prevent communication with the surface. Uninstall Parallels for your computer to restore communication.

Changing track output assignments takes a long time. (102062)

If your Pro Tools system uses a Mojo and a Magma PE6R4 expansion chassis, changing a track Output assignment can take between 4–8 seconds with a 24-bit, 96 kHz session. Pro Tools systems with a Mojo and other expansion chassis may also exhibit this behavior. In contrast, changing track Input assignments, as well as deactivating and reactivating track occurs almost immediately.

Pro Tools|HD Systems

Slot order for BlackMagic Design DeckLink Extreme II PCIe card and Pro Tools|HD PCIe cards (106661)

BlackMagic Design recommends placing the DeckLink Extreme II video playback and capture card in Slot 3 of your PCIe Macintosh. You may have difficulty placing the HDMI daughter card in an unused slot between slots 0 and 1 in your Power Mac computer due to the full size of Pro Tools HD cards. In order to accommodate an additional Pro Tools|HD Accel card, the DeckLink Extreme II was extensively tested in PCIe slot 1 as well. No decrease in performance was found.

Pro Tools|HD Native Systems

Pro Tools|HD Native card should be installed in PCIe slot 3 or slot 4 of Woodcrest and Clovertown Mac Pro computers for optimum performance. (PTSW-1771)

Clovertown and Woodcrest Mac computers cannot support a PCIe device of speed greater than 1x in PCIe Slot 2 without PCIe Slot 1 being lowered to 8x. (Note that Avid does not test graphics cards at less than their ideal speed of 16x.) To avoid this problem, install your Pro Tools Native card in PCIe slot 3 or slot 4 of your Clovertown or Woodcrest era Mac computer.

Clovertown Mac Pro computers do not have the PCIe bandwidth required to use more than two 4x PCIe cards at full speed. (PTSW-1657 and PTSW-1456)

Clovertown Mac Pro computers with an ATTO UL5D card, a BlackMagic Design's Decklink 3 Video Capture card, and a Pro Tools|HD Native card do not have the PCIe Bandwidth required to run all three cards at full speed. In this configuration, three 4x PCIe cards are being called for, while Clovertown Mac Pro computers can only accommodate two 4x cards and one 1x card. Consequently, one card must be run at less than full speed. Avid has not tested any down-throttled combinations and as such this is an unsupported configuration. Consider the following options as workarounds: slow down the built in graphics card to 8x or remove the SCSI HBA card and use SATA instead of SCSI drives.
Similarly, a Pro Tools|HD Native card, an ATTO Celerity ES-41 Fiber Optic Network Adapter card, and a BlackMagic Design’s DeckLink 3 card cannot be combined in Clowertown era Mac Pro without one card being used at less than its optimal PCIe bandwidth. Since Pro Tools support for Unity MediaNet 5 is limited to push/pull scenarios, Avid recommends that the ATTO Celerity card be down-throttled by installing it in the 1x PCIe slot, and that the Pro Tools|HD Native and DeckLink 3 cards be installed in the 4x PCIe slots.

Avid strongly recommends against running the Pro Tools|HD Native card or BlackMagic Design DeckLink 3 card at less than full speed.

---

**Issues Resolved in Pro Tools 9.0.6**

This section lists the issues resolved in Pro Tools 9.0.6 and Pro Tools HD 9.0.6.

**Pro Tools would momentarily freeze every minute after changing the computer name in the OS X hostconfig file (as recommended in System 5 and Pro Tools manual) and disconnecting the computer from the Internet. (PTSW-154157)**

Pro Tools will not momentarily freeze under these conditions.

**Plug-in automation was lost when copying between multi-mono and multi-channel versions of the same plug-in. (PTSW-138658)**

Plug-In automation can now be copied between multi-mono and multi-channel versions of the same plug-in.

**When routing through a bus, Low Latency Monitoring would not function properly. (PTSW-140766, PTSW-138470, PTSW-140660)**

With Low Latency Monitoring (LLM) mode enabled, using an internal bus to route audio from one track to another now correctly bypasses the Low Latency Monitoring function. Note that Low Latency Monitoring works by routing audio at the hardware level, avoiding the delays inherent in sending audio to and from the Pro Tools mixer. For all devices except HD Native, you can only use Inputs and Outputs 1 and 2 for the LLM hardware path. For HD Native, you can select any I/O pair for the LLM path in the I/O Setup dialog.

**On Mac OS X 10.7.x (“Lion”), when changing buffer settings in Playback Engine with the “Minimize Additional I/O Latency” option enabled, Pro Tools would quit unexpectedly. (PTSW-142680)**

The “Minimize Additional I/O Latency” option now works reliably on Mac OS X Lion.

**In Destructive Punch mode, when punch commands are issued within a couple seconds of play or start commands are issued from a 9-pin controller connected to the dubber satellite system. (PTSW-147702)**

Satellite sync is now reliable in Destructive Punch mode when systems are controlled from 9-pin devices and commands are issued shortly after transport starts.

**Pro Tools would not import asymmetric audio fades via AAF from Media Composer 6. (PTSW-150761)**

Pro Tools can now import asymmetric audio fades via AAF from Media Composer 6.

**Clip pan would not be imported via AAF from Media Composer 6. (PTSW-151717)**

Pro Tools will now import clip pan via AAF from Media Composer 6.

**After duplicating playlists and committing an Elastic Audio track, Pro Tools would quit unexpectedly after redoing an undo. (PTSW-152396, PTSW-127272).**

Pro Tools now works reliably under these conditions.

**The Pro Tools transport would become unresponsive after attempting to scrub during a record pass. (PTSW-153661)**

Pro Tools now correctly handles scrub commands during a record pass. Record mode will be exited and scrub will commence. Note that longer record passes may require more time to exit Record mode.
Pro Tools would post a warning after enabling Destructive Punch or Track Punch and pressing Play. (PTSW-138915, PTSW-141250)

Destructive Punch and Track Punch modes now operate correctly.

Fader caps that were dimmed in normal mix view would not appear dimmed in Narrow Mix view. (PTSW-149966)

Fader caps now appear dimmed in both mix views.

On Mac OS X 10.7.x (“Lion”), when the Pro Tools Edit window was displayed at or near full screen resolution on 27-inch or larger monitors, some elements would not draw correctly (such as MIDI notes, region edges during trimming, and automation breakpoints and connector lines during editing). (PTSW-143349)

Graphical elements now display properly on Mac OS X 10.7.x (“Lion”) when large or multiple monitors are used.

On Mac OS X 10.7.x (“Lion”), unexpected volumes were displayed in the Workspace browser with names including “net,” “home,” or random characters. (PTSW-141317)

The Workspace browser no longer displays unexpected volumes on Mac OS X 10.7.x (“Lion”).

Video Satellite (Media Composer) would quit unexpectedly when unlinked during playback. (PTSW-46314)

Video Satellite can now be unlinked during playback.

In Mac OS X, the search field in Import Audio dialog would not accept ’p’ and ’s’ keystrokes as input. (PTSW-141140)

The Import Audio dialog search field accepts all legal input values.

Fast-forward and rewind speed was not adjustable. (PTSW-148318)

Fast-forward and rewind speed can now be adjusted in Pro Tools Preferences. (Note that this setting is a system preference, not a session preference.)

When using 9-pin Machine Control with Satellites and Video Satellite, there were performance issues with transport control. (PTSW-151352, PTSW-142368, PTSW-142320, PTSW-152790, PTSW-151212, PTSW-151201, PTSW-151196)

Systems using 9-pin Machine Control with Satellites and Video Satellite now perform transport commands reliably.

On systems with a 9-pin controller attached and “Allow 9-Pin Commands in Local Mode” enabled, cued playback would not work. (PTSW-151835)

Cued playback now functions properly under these conditions.

When controlled from a EUCON-enabled controller, TrackPunch could not be toggled more than once per recording pass. (PTSW-135001)

TrackPunch now works reliably on EUCON-controlled systems.

When using Pro Tools HD Native with a VENUE HDx interface, switching VENUE from Stage mode to Virtual Soundcheck mode would result in Pro Tools not being able to play. (PTSW-142162)

VENUE Virtual Soundcheck now works more reliably with Pro Tools HD Native.

Pro Tools would not start playback when Play was pressed, but instead would pause. (PTSW-142640)

Pro Tools does not go into a unwanted Pause state on initiating playback.

Counters would not update smoothly in Fast-Forward or Rewind. (PTSW-134593)

Counters now update smoothly in Fast-Forward or Rewind.

When importing certain NewsCutter sequences, Pro Tools would post a warning. (PTSW-147064)

All NewsCutter sequences now import correctly.
Pro Tools would emit unwanted noise when Minimize I/O Latency is turned on in Playback Engine settings (OS X 10.6.8 and 10.7.x only). (PTSW-137937)

The Minimize I/O Latency feature now works correctly on OS X 10.6.8 and 10.7.x.

Activating and deactivating Remote Mode is slower with SYNC HD than with SYNC I/O. (PTSW-136025)

Activating and deactivating Remote Mode with SYNC HD is now faster.

When an HD Native card with firmware 1.0 is installed and 32 bit boot mode is on, the computer would not start. (PTSW-142906) - Mac only

Mac OS X 10.6.8 and 10.7.x can now be booted into 32-bit mode when an HD Native card with firmware 1.0 is installed.

When entering Scrub using Control modifier key, the Scrub function does not work on the first spin of the Scrub Wheel. (PTSW-136969)

Clutch Scrub mode now works on first wheel spin.

Pressing an Edit Mode keyboard shortcut (F1-F4) simultaneously with an Edit Tool keyboard shortcut (F5-F10) incorrectly engages the Smart Tool. (PSTW-1444679)

The Smart Tool is now engaged only when pressing combinations of F6-F8 shortcut.

HyperControl and DirectLink “Track <>” buttons would become non-responsive in Pro Tools when used with another controller. (HYP-228)

HyperControl and DirectLink “Track <>” buttons now work reliably with another controller.

HyperControl and DirectLink “Track <>” buttons would unexpectedly Record Enable tracks. (HYP-231)

HyperControl and DirectLink “Track <>” buttons now work reliably in Pro Tools.

Axiom Pro banks an extra partial bank when EUCON is active. (HYP-225)

Axiom Pro now banks correctly when EUCON is active.

Axiom MKII 25 could assign Master Fader to DB-33 plug-in Master Level but was not able to control it. (HYP-230)

DB-33 Master Level is now controlled by Axiom MKII 25 Master Fader when assigned.

Enabling EUCON would temporarily disable HyperControl. (HYP-222)

HyperControl is no longer disabled by EUCON.

Axiom Pro would display its personality version as 1.05. (HYP-205)

Axiom Pro correctly displays its personality version as 1.0.5.

---

**Issues Resolved in Pro Tools 9.0.5**

This section lists the issues resolved in Pro Tools 9.0.5 and Pro Tools HD 9.0.5.

When using Satellite Link or Video Satellite with two or more satellite systems, after fast-forwarding or rewinding, satellite systems would not always stop on the same frame as the admin system. (PTSW-146143)

All Satellite systems now stop on the same frame if the Stop command is issued from a Pro Tools system. If the Stop command is issued from a Video Satellite (Media Composer) system, a two-frame offset between the Video Satellite and the Pro Tools Satellites may occur.
When Pro Tools is configured for Remote Mode operation, switching in and out of Remote Mode would take a long time.  
(PTSW-141004)

Pro Tools now switches in and out of Remote Mode in a shorter time.

While Pro Tools is in X-OR Solo mode, disengaging solo from the MIDI Editor window caused the Solo mode to change unexpectedly to Latch, without changing the displayed mode.  
(PTSW-11702)

Disengaging solo from the MIDI Editor window no longer changes the Solo Mode.

Large, densely-automated Pro Tools sessions could encounter out-of-memory errors or unexpected asserts during editing.  
(PTSW-141623)

Automation breakpoint memory usage has been optimized to reduce the total amount of memory required. The amount of reduction depends on the structure of the session and the amount of automation in the session. If out-of-memory errors persist, you can thin automation data (Edit > Automation > Thin All) to reduce the occurrence of these errors.

Certain NewsCutter AAF files did not import into Pro Tools correctly.  
(PTSW-143388)

NewsCutter AAF files now import into Pro Tools correctly.

The Original Time Stamp of MXF media files in an AAF export was not being exported correctly, resulting in a timecode offset.  
(PTSW-141772)

The Original Time Stamp of MXF media files in an AAF export is now correct.

Certain commands were incorrectly listed in the undo queue, resulting in “error -35” messages.  
(PTSW-135635)

Commands that are cancelled during operation, and thus should not be available in the Undo Queue, are now properly not included in the Undo queue.

HD Native firmware 1.02 (shipped with Pro Tools 9.0.4) is not compatible with Windows.  
(PTSW-141269)

HD Native firmware has been updated to 1.03 and is now fully compatible with all supported Mac and Windows configurations.

⚠️ Be sure to update HD Native firmware to version 1.03 before updating to Mac OS X 10.6.8 or Mac OS X 10.7.x (Lion).  
It is not possible to upgrade HD Native firmware from those versions of Mac OS X.

It was not possible to set Pitch Bend value to zero while editing MIDI data.  
(PTSW-141610)

It is now possible to set Pitch Bend value to zero while editing MIDI data.

Bounce to QuickTime would not work if the bounce source was multichannel (greater than stereo).  
(PTSW-137250)

Bounce to QuickTime now works with all source channel formats. Bouncing any source (including greater-than-stereo) to QuickTime results in a stereo file.

Pro Tools would crash when swapping plug-ins while in Learn mode for HyperControl.  
(HYP-209)

Pro Tools does not crash when swapping plug-ins while in Learn mode for HyperControl.

When Project Mix I/O was used in conjunction with a second control surface, the bank select function on the Project Mix I/O would cease to function.  
(HYP-176)

Project Mix I/O can now be used simultaneously with other control surfaces.

When using HyperControl, the Sends Soft Key would not scroll through the Sends.  
(HYP-110)

When using HyperControl, the Sends Soft Key now scrolls through the Sends.
When using HyperControl, it was possible to lose contact with a Master Fader track for a few seconds if the track was in the selected bank and was alternately controlled with a bank fader and a Master Fader. (HYP-227)

When using HyperControl, Master Fader control will not be lost if controlling the fader from two locations.

---

**Issues Resolved in Pro Tools 9.0.4**

This section describes an issue resolved in Pro Tools HD 9.0.4 for Mac systems only.

**The 17-inch, Early 2011 “Thunderbolt” MacBook Pro (MacBookPro8,3 MC725LL/A) does not recognize Pro Tools audio interfaces when using an HD Native card in a Magma ExpressBox1 expansion chassis. (PTSW-137395)**

With Pro Tools HD 9.0.4 on Mac OS X, you can update the firmware on the HD Native card to version 1.02 (using a non-“Thunderbolt” Mac) to fix this compatibility issue.

The HD Native card firmware cannot be updated from the 17-inch, Early 2011 “Thunderbolt” MacBook Pro when using a Magma ExpressBox1 expansion chassis; the update will fail with Error number -1166. You must update the HD Native card firmware using a non-“Thunderbolt” Mac. If you do not have access to a non-“Thunderbolt” Mac to perform this update, contact Avid Customer Success.

⚠️ *This HD Native card firmware v1.02 update is not compatible with computers running Windows 7. If an HD Native card that has been updated to firmware v1.02 is installed in a Windows 7 computer, its firmware must be reset to factory settings. See “Resetting HD Native card Firmware to Factory Settings” on the next page for instructions on resetting HD Native card firmware.*

**Updating HD Native Card Firmware**

⚠️ *This HD Native card firmware v1.02 update is for Mac only, and is not compatible with computers running Windows 7.*

To update HD Native card firmware using a non-“Thunderbolt” Mac:

1. Install Pro Tools HD 9.0.4 software on the non-“Thunderbolt” Mac. (See the Pro Tools Installation Guide for instructions.)
2. Install the HD Native card in the non-“Thunderbolt” Mac. (See the HD Native User Guide for instructions.)
3. Launch Pro Tools HD. Pro Tools prompts you to update the HD Native card firmware.
4. Click OK.
5. After the firmware update process is completed, restart the computer.
Resetting HD Native Card Firmware to Factory Settings

⚠️ The HD Native card firmware v1.02 update is not compatible with computers running Windows 7. If an HD Native card that has been updated to firmware v1.02 is installed in a Windows 7 computer, its firmware must be reset to factory settings using Pro Tools HD version 9.0.3 or lower.

To reset HD Native card firmware to factory settings:

1. Verify that you need to do this procedure (see the warning above). Resetting your HD Native card firmware to factory settings is not a common requirement.

2. Install the HD Native card in your Windows computer. (See the HD Native User Guide for instructions.) Leave the computer case open so that you can access the card.

3. Turn on the computer.

4. Press the small button on the top edge toward the back of the HD Native card.
   - The LEDs on the front side of the board turn off.
   - The LED on the back side of the board flashes at one-second intervals.

5. Wait five seconds.

6. Press the small button on the card a second time.
   - The LEDs on the front side of the board come back on and flash at one-second intervals.
   - The LED on the back side of the board continues to flash at one-second intervals.

7. Restart the computer. Make sure to choose Restart instead of turning the computer off and on again. (If you power down completely, you will need to repeat this procedure from the beginning.) After the computer restarts:
   - The LEDs on the front side of the board flash at one-second intervals.
   - The LED on the back side of the lights solid, then flashes at 1/4-second intervals.

8. After the computer has restarted, launch Pro Tools HD version 9.0.3 or lower. Pro Tools prompts you to update the HD Native card firmware.

9. Click OK.

10. After the firmware update process is completed, restart the computer.
Issues Resolved in Pro Tools 9.0.3

This section lists the issues resolved in Pro Tools 9.0.3 and Pro Tools HD 9.0.3.

Pro Tools could alter I/O routing in the session when using Import Session Data command and selecting the Match Tracks option. (PTSW-136881)

I/O routing is now correctly preserved in the destination session when importing session data with the Match Tracks option.

Pressing the Spacebar after entering new Session Start values while in the Session Setup window would cause Pro Tools to crash. (PTSW-136188)

Pro Tools now starts playback when the Spacebar is pressed while entering a Session Start value in the Session Setup window.

Grid lines would fail to appear in the Edit window after switching from Grid mode to Slip mode. (PTSW-137120)

Grid lines now correctly appear in the Edit window when changing Edit modes.

Nudging audio within a region could affect audio on alternate playlists instead of the currently displayed track playlist. (PTSW-138403)

In this scenario, now only the currently selected playlist region’s material is adjusted.

Saved sessions did not store a session’s PAL status on systems with the Avid Mojo attached. The sessions would revert to NTSC when reopened, and would have to be set back to PAL. (PTSW-135559)

Sessions now save NTSC/PAL status correctly on systems with an Avid Mojo.

MXF video files created with Avid Media Composer would sometimes not play in Pro Tools due to a software decompression error. (PTSW-135856)

MXF video files imported from Avid Media Composer now play correctly in Pro Tools.

If a video track in Pro Tools was triggered to record by incoming time code when Transport=Machine, all currently recording audio and video regions would not be saved to disk when the transport was stopped. (PTSW-3104)

Audio and video are now correctly saved when recording under these conditions.

When using a EUCON controller on a system with Machine Control, scrub and shuttle functions would not work. (PTSW-137179)

Scrub and shuttle commands with EUCON controllers (Artist Series, System 5 and System 5-MC) now work properly on systems with Machine Control.

When using the M-Audio Profire 2626 with Pro Tools, the smallest available Hardware Buffer Size setting was 128 samples. (PTSW-135423)

The M-Audio Profire 2626 now supports Hardware Buffer Size settings of 32 and 64 samples.

On Axiom Pro, the Master Fader was not responding properly to Fader 9 unless its Bank Fader was at maximum level. (AXPRO-1)

The Master Fader now responds correctly.

On Axiom Pro, “PanL” and “PanR” indications were still present when selecting mono tracks. (AXPRO-10)

When a mono track is selected, a “Pan” indication is now correctly displayed.

HyperControl would not always activate upon closing the Peripherals dialog. (HYP-3)

HyperControl now activates correctly upon closing the Peripherals dialog.
With HyperControl, the Master Fader had to be assigned to a Bank Fader for proper linking to Keyboard Fader 9 (HYP-186, HYP-4)

The Master Fader now links correctly to Fader 9.

With HyperControl, there was a disparity between left and right response from rotary encoders (HYP-122)

The rotary encoders now respond symmetrically to the left and right.

With HyperControl, rapid bank switching during a large (80 or more tracks) session could cause the bank to switch in non-multiples of 8 when an additional controller is connected. (HYP-115)

Bank switching now conforms to multiples of 8.

With HyperControl, track select state was not retained when reopening a session that was saved with tracks selected. (HYP-120)

The select state of tracks is now retained correctly when reopening a session.

Inserts added when HyperControl is in Insert Mode were not registered by the HyperControl Insert page. (HYP-117)

Inserts are now properly registered in the Insert page when added in Insert mode.

With HyperControl, panning knobs would not center (value 64) in DirectLink. (HYP-177)

Panning knobs now center correctly in DirectLink.

With HyperControl, when multiple faders were moved, communication could be lost and faders could be stuck at their extremes (value 127 or 0). (HYP-172, HYP-187)

Communication is now maintained when multiple faders are moved to their extremes.

With HyperControl, sliders were sluggish in DirectLink. (HYP-143)

Slider response is now corrected in DirectLink.

With HyperControl, when using DirectLink to control DB33, the faders move in the opposite direction of the drawbars. (HYP-161)

Faders now reflect DB33 drawbar mode correctly.

With HyperControl, the display on M-Audio keyboard controllers was garbled when there were Japanese-named tracks. (PTSW-126066)

Controllers now display track numbers for tracks that have names with Japanese characters.
Issues Resolved in Pro Tools 9.0.2

This section lists the issues resolved in Pro Tools 9.0.2 and Pro Tools HD 9.0.2.

General Pro Tools Issues

When using the Save Copy In command to save a copy of a session, if the session was saved at a different sample rate, Send automation would inadvertently change duration. In addition, the duration of automation on sample-based Instrument tracks was not converted correctly. (PTSW-135550)

When using Save Copy In to save a session at a different sample rate, Send automation is now properly sample rate converted. All automation on sample-based instrument tracks is now sample-rate-converted.

While playing back a session, if you clicked or made a selection in any of the Pro Tools counters, playback was interrupted. (PTSW-57055)

When you click or make a selection in a counter field, playback is not interrupted until a new value is entered, either by typing in the counter field and pressing Return (Mac) or Enter (Windows), or by dragging in the counter field.

Choosing “Select > Unused” from the Region List menu would incorrectly clear the Undo queue. (PTSW-135605)

Choosing “Select > Unused” from the Region List menu leaves the Undo queue untouched.

Pro Tools was regenerating fades instead of relinking to existing fade files, resulting in additional fade files and longer session open times. (PTSW-125305)

Pro Tools now looks for a Fades folder before regenerating fades.

On a Pro Tools system with dual monitors positioned vertically, clicking in the Edit window reduces it to only fit in the top monitor. (PTSW-124174)

Clicking in the Edit Window will no longer reduce it to only fit in the top monitor. When a window is moved, resized or clicked, and all of it is visible, it stays in its original location.

Numeric Entry text fields in Pro Tools (such as counters or parameter values) can now be modified using a mouse scroll wheel (No Item Number).

To modify a numerical value, click in the numerical field and scroll up or down to increment or decrement the value.

When copying Send Pan automation and pasting it to another track with the Copy Special > Pan Automation command, the Send Pan automation is incorrectly pasted into the Main Pan playlist. This occurs when the Send Pan on the source track is following Main Pan. (PTSW-120918)

When copying Send Pan automation and pasting it to another track with the Copy Special > Pan Automation command, automation is now pasted into the correct playlist on the destination track.
Recording

When recording in Continuous or Center Playhead Scrolling Modes, the recorded audio runs away from the center of the screen. When zooming in or out or resizing windows while recording, visual anomalies and system instability can occur. (PTSW-3120)

When recording in Continuous or Center Playhead Scrolling Modes, visual anomalies and system instability no longer occur.

The Transport Record Lock feature was unavailable in Pro Tools 9 with Complete Production Toolkit 2 and in Pro Tools HD 9. (PTSW-135268)

The Transport Record Lock feature is now available in Pro Tools 9 with Complete Production Toolkit 2 and in Pro Tools HD 9.

When using Delay Compensation and recording MIDI to an Instrument track while simultaneously bussing the Instrument track’s audio output to an Audio track, the recorded audio would be out of sync with the MIDI. (PTSW-56742)

When using Delay Compensation, recorded audio and MIDI now line up correctly in the Edit window timeline.

Editing

After switching to waveform view from volume playlist view (after trimming the volume level), it was not possible to Shift-click with the Grabber tool to select a region. (PTSW-127571)

It is now possible to use the Grabber and other tools to Shift-select multiple regions after switching the playlist view.

When switching display of loop-recorded takes in a grouped track using the Takes pop-up menu, Pro Tools did not properly switch loop-recorded takes on the other tracks in the group, leading to a mismatch of takes among grouped tracks. (PTSW-132417)

Pro Tools now correctly switch takes on all grouped audio tracks recorded together when Matching Criteria are set appropriately. To switch Takes on all group members, Matching Criteria must be set to Alternate Match > Track Name and In Addition To: Region Start and End.

If two sessions contained the same region, with one session having a sync point in that region and the other session having a different sync point (or none), importing one session into the other would result in an incorrectly placed region on the timeline. In certain cases this would cause Pro Tools to quit unexpectedly. (PTSW-129060)

In this scenario, the region is now imported and a new region is created, having a different sync point.

When zoomed in while in Edit modes other than Grid mode, lines and numbers in the Edit window rulers would not appear consistently at a finer resolution than the grid setting. (PTSW-133537)

The grid setting no longer has an effect on the visibility of lines and numbers in the rulers when zoomed in. When in Grid mode, the rulers shows lines and numbers according to the grid setting.

When a set of overlapping regions was moved with the Object Grabber to a different track, the overlap would be reversed, spoiling the edit. (PTSW-127690)

When a set of overlapping regions is moved with the Object Grabber to a different track, the overlap is now correctly preserved.

When attempting to edit a fade out that was immediately followed by a very long region, Pro Tools had insufficient memory to complete the edit. (PTSW-127257)

Editing a fade out that is immediately followed by a very long region will no longer result in an “out of memory” error.

Undoing a playlist Delete/Cut done in Playlist view after switching to Waveform view caused Pro Tools to quit unexpectedly. (PTSW-129713)

All edits that are done in Playlists are now removed from the Undo Queue when switching to Waveform view, preventing any unexpected behavior.
In certain conditions, Pro Tools incorrectly classified audio playlists as Unused, leading to accidental deletion when using the Delete Unused Playlist command. (PTSW-130472)

Pro Tools now classifies audio playlists correctly, preserving playlists that are not empty when using the Delete Unused Playlist command.

When Command Key Focus is enabled, the key command to Separate Selection incorrectly cleared the selection. (PTSW-133271)

When using Command Key Focus, the key command to Separate Selection now works correctly and consistently.

**Mixing and Signal Routing**

When selecting the output of a Master Fader track, Pro Tools would assign the wrong output path. (PTSW-135270)

Pro Tools now correctly assigns the selected output path on Master Fader tracks.

When changing the output active/inactive state of outputs in sessions with complex routing, all of the busses were reset and all mixers would rebuild, resulting in a long waits or system errors. (PTSW-133388)

The number of paths and busses that are reset by toggling the active state of an output or mapped output bus has been optimized, greatly reducing the number of mixers that must be rebuilt and the amount of time complete the operation.

The Pro Tools output selector only displayed some of the channel meters for a 6-channel surround path on a Master Fader. (PTSW-56960)

The output window now properly displays all channel meters of for greater than stereo Master Fader tracks.

The presence of inactive paths would cause the Pro Tools to assign an incorrect path when a path was selected in the Output Selector pop-up menu. (PTSW-132658, PTSW-132734)

With inactive paths present, Pro Tools now correctly assigns the path chosen with the Output Selector pop-up menu.

**I/O Setup**

Audio would not pass on output paths that were overlapped by wider paths that were made inactive. This condition could be caused by making a bus mapped to an output path inactive. (PTSW-132325, PTSW-134450)

The I/O Setups dialog no longer allows overlapping inactive paths, and now posts a warning dialog when one or more output paths are overlapped by a wider, inactive path.

When mapping a mono bus to a larger output path in I/O Setup, it automatically mapped to the left channel and could not be changed. (PTSW-126545)

In I/O Setup, a mono path can now be mapped to any channel of a surround path. A pop-up menu appears across the corresponding chicklet of the mono path. Use this pop-up to route signal to any of the channels of the mapped surround path. In channel formats with a Center channel (LCR, 5.0 5.1, 7.0, 7.1), the mono path is assigned to the Center channel by default. Note that Mono-to-Stereo or Mono-to-Quad output mappings are not supported.
In the Bus page of the I/O Setup dialog, the standard Pro Tools key modifiers for Do To All, Do To Selected, Cascade Across All, and Cascade Across Selected did not function when mapping mono output busses to multichannel output paths. (PTSW-135316)

The following key commands now work in the Bus page of the I/O Setup dialog:

◆ To assign the same channel to all mono busses mapped to a multichannel output path, Option-click (Mac) or Alt-click (Windows) the mono bus indicator and select the channel from the pop-up menu.

◆ To assign the same channel to all selected mono busses mapped to a multichannel output path, Option-Shift-click (Mac) or Alt-Shift-click (Windows) a mono bus indicator and select the channel from the pop-up menu.

◆ To assign ascending (cascading) channels to all mono busses mapped to a multichannel output, Command-Option-click (Mac) or Control-Alt-click (Windows) the mono bus indicator of the top-most mono bus and select the first channel from the pop-up menu.

◆ To assign ascending (cascading) channels to all selected mono busses mapped to a multichannel output, Command-Option-Shift-click (Mac) or Control-Alt-Shift-click (Windows) the mono bus indicator of the top-most mono bus and select the first channel from the pop-up menu.

MIDI

When exporting MIDI files from Pro Tools, Memory Location markers are displaced from their original positions, making exported MIDI file unusable. (PTSW-133659)

Memory Location markers are no longer displaced when a MIDI file is exported from Pro Tools.

If you resized Automation lanes during playback, Pro Tools would quit unexpectedly. Would only occur if you recorded MIDI Data then attempt to resize an automation lane during playback. (PTSW-134745)

Resizing Automation Lanes during playback after a MIDI Record Pass will no longer cause Pro Tools to quit unexpectedly.

In the Edit window, it is now possible to trim the start and end points of selected MIDI notes by the current Nudge value (No Issue Number).

11 With the Time Grabber tool, select the MIDI notes you want to trim.

12 Do one of the following:
   • While pressing Alt (Windows) or Option (Mac), press Plus (+) or Minus (–) on the numeric keypad to trim the start point of the selected MIDI notes by the Nudge value.
     – or –
   • While pressing Control (Windows) or Command (Mac), press Plus (+) or Minus (–) on the numeric keypad to trim the end point of the selected MIDI notes by the Nudge value.

In the Edit window, it is now possible to transpose selected MIDI notes by semi-tonal increments using Plus (+) or Minus (–) on the numeric keypad. (No issue Number)

1 With the Time Grabber tool, select the MIDI notes you want to transpose.

2 Do one of the following:
   • While pressing Start (Windows) or Control (Mac), press Plus (+) on the numeric keypad transpose the selected MIDI notes up by one semitone.
     – or –
   • While pressing Start (Windows) or Control (Mac), press Minus (–) on the numeric keypad transpose the selected MIDI notes down by one semitone.

After importing a MIDI File that includes Memory Locations, selecting and deleting Memory Locations incorrectly removed additional, unselected Memory Locations. (PTSW-135231)

Now, under these conditions, only the selected Memory Locations are deleted.
Plug-Ins and Third-Party Software

Under certain conditions, when the Expander/Gate Dyn III plug-in was inactive, it emitted a spurious audio signal when reactivated. (PTSW-123386)

The Expander/Gate Dyn III plug-in now re-activates correctly and does not emit spurious audio signal.

When using the Sonic NoNoise Production Declicking plug-in, it was not possible to fine-adjust Width controls in increments of milliseconds. (PTSW-131667)

It is now possible to fine-adjust the Width controls of the Sonic NoNoise Production Declicking plug-in.

When processing an audio file with Sonic NoNoise Manual Declicking Type E DeCrackler AudioSuite plug-in, a small segment of silence was appended to the end of the processed audio file. (PTSW-57334)

When processing audio using the Sonic NoNoise Manual Declicking Type E DeCrackler AudioSuite plug-in, no additional silence is appended to the file.

When using the Nordic meter type in the PhaseScope plug-in, the meter was reporting incorrect values for pulsed signals. (PTSW-134543)

The Nordic meter type in the PhaseScope plug-in now reports correct meter values for pulsed signals.

When using some AudioSuite plug-ins that receive multi-channel input (in “multi-input mode”) from multiple tracks (such as Neyrinck SoundCode for Dolby E) and the input channel stem formats did not match the targeted output format, the processing would fail and Pro Tools would post an error message. (PTSW-136058)

It is now possible to use AudioSuite plug-ins that require multi-channel input (in “multi-input mode”) from multiple selected tracks, provided the correct number of channels (across all tracks) are selected.

When using the UAD2 Satellite and Digi 002/003, Pro Tools quits unexpectedly when the UAD Meter is launched. (PTSW-136010)

Pro Tools now operates properly when using the UAD Meter with UAD2 Satellite and Digi 002/003.

Activating a deactivated mono-to-stereo RTAS plug-in during playback caused only the left channel to play back, and when playback was stopped, audio continued to play for a few seconds. (PTSW-127561)

Mono-to-stereo RTAS plug-ins can be activated during playback and correctly play audio in both channels.

Control Surfaces

When accessing HEAT controls (Drive and Tone) from D-Control or D-Command channel strip, if the encoder knob was touched to display the value of a control, the touch value display incorrectly reverted back to the parameter name after 1 second. (PTSW-130808)

When accessing HEAT controls from D Control or D Command, the scribble strip display shows the current value of the control as long as you touch the encoder knob, and reverts to the parameter name when released.

ICON units (D-Control and D-Command) would intermittently stop transmitting Ethernet data to Pro Tools, requiring the user to power cycle the ICON unit to reestablish communication. (PTSW-132201)

ICON units now correctly transmit Ethernet data to Pro Tools.

When using Satellite Link, Pro Tools would not always respond to transport commands coming from two or more control surfaces at the same time. (PTSW-133626)

When using Satellite Link, multiple control surface transports now control Pro Tools more reliably when used simultaneously.
It was not possible to enable or disable 9-pin remote control of Pro Tools using the dedicated switch on D-Command (labeled “9-pin Remote” on D-Command, and “Machine” on D-Command ES). (PTSW-134286)

The dedicated switch on D-Command now correctly enables/disables 9-pin remote control of Pro Tools.

With Page Scrolling enabled, the Edit window would fail to scroll after scrubbing with the Jog wheel on ICON (D-Control and D-Command). (PTSW-131420)

The Edit window scrolls correctly and consistently when scrubbing with the Jog wheel on ICON control surfaces.

D-Control and D-Command would not update the name of a Send on the control surface when it was created via the New Track option in the Sends pop-up menu. (PTSW-134672)

Send names across the D-Control or D-Command control surface reflect the current state of the Pro Tools application.

**File and Session Data Import**

In certain conditions, Pro Tools would quit unexpectedly when importing session data. (PTSW-134408, PTSW-134909, PTSW-134904)

Pro Tools now imports session data more reliably.

When importing session data from a legacy session into a complex 8.1.x session, changes to the bus configuration would cause a large number of mixers to rebuild, with the result that the import would take a long time to complete (in some cases, five minutes or longer). (PTSW-133387)

The number of paths and busses that are reset by an import session data operation has been optimized, greatly reducing the number of mixers that must be rebuilt, thereby decreasing the amount of time to complete the import.

**Video**

On a Pro Tools video track, when the frame rate is set to 23.976, the Frame Rate display was truncated to appear as “23.97,” which could be conflated with a frame rate of “29.97” and cause confusion. (PTSW-57252)

When the Frame Rate display for 23.976 is truncated, it now correctly displays as “23.98.”

When 720p59 or 1080p59 video was pulled up by 0.1%, the video frame rate indicator on the video track changed from “59.94fps” to “59fps” instead of to “60fps.” (PTSW-129902)

The video frame rate indicator shows the correct frame rate on the video track, showing “60fps” in white text (because it is an even multiple of the session frame rate).

If a video record pass was undone while another video record was in progress, Pro Tools would quit unexpectedly. (PTSW-135874)

It is now possible to undo a previous video record while recording a second video record pass.

When Insertion Follows Playback was enabled, video would locate back to the starting play position after stop. (PTSW-13353)

Pro Tools now correctly locates the video to the stop position when using Insertion Follows Playback.

When extending or trimming an audio selection with keyboard shortcuts (Cntrl (Windows) or Command (Mac), or Shift+Cntrl (Windows) or Shift-Command (Mac) and the + (plus) or - (minus) keys) the Pro Tools video display did not follow the out point of the selection. (PTSW-57180)

When extending or trimming an audio selection with keyboard shortcuts, video display follows the out point of the selection.
Avid Interoperability, File Exchange and Field Recorder Workflows

Pro Tools would post an assertion error when importing an AAF referencing multi-channel WAV files. (PTSW-135157)

Such an AAF can be created in Media Composer with a sequence that references multi-channel WAV files via AMA (Avid Media Access), and is then consolidated on export. Pro Tools now posts a notice that AAF import of multi-channel WAV files is not supported in the Translation Notes. In some cases, these files can be re-linked after the import process. Alternately, the video editor can split to mono prior to export.

When importing an AAF file created in Media Composer that contains Auto-Gain (volume automation) written after a crossfade, the automation data was offset later in the session by half of the fade length. (PTSW-122815)

Pro Tools now correctly interprets Auto-Gain information written after a crossfade when imported from Media Composer.

When importing an AAF from Media Composer that contains audio clips with both clip-based gain and either rendered AudioSuite or Audio EQ effects, Pro Tools imported “double gain” if “Convert Clip Gain to Automation” was selected and “Ignore Rendered Audio FX” was deselected in the Import Session Data dialog. (PTSW-127305)

Pro Tools now does not convert clip-gain to automation on clips that also contain a rendered AudioSuite or Audio EQ effect.

Files imported via AAF from Media Composer contain incorrect Shoot Date time (PTSW-135829).

Field Recorder files which have been passed through Media Composer have a correct Shoot Date, but incorrectly show the time of day as midnight or 1 am. Pro Tools 9.0.2 now only shows the Shoot Date, rather than the incorrect time of day.

Pro Tools calculated Shoot Date based on the computer’s current time zone. This conversion would cause Shoot Date to display incorrectly unless your computer was set to the Greenwich Mean Time (GMT) time zone. (PTSW-120859).

Pro Tools will now always display the actual Shoot Date of the files, so that Shoot Date can be used as a valid match criteria when searching for field recorder channel matches. This fix applies to all sessions opened in Pro Tools 9.0.2 and later, including sessions created in previous versions of Pro Tools.

In cases where a file’s Shoot Date is missing, Pro Tools copies the File Creation Date (based on the computer’s current time zone) to the Shoot Date Field. In this case, Pro Tools may still display the Shoot Date incorrectly if the operating system has updated the File Creation Date based on time zone.

Pro Tools exhibited decreased system performance when working with MXF audio media. (PTSW-135050, PTSW-132760, PTSW-135089, PTSW-135056)

Session performance with MXF media is improved in the following areas:

- Faster session open times for sessions containing MXF audio media
- Faster AAF import times for sequences with embedded or linked MXF audio media
- Faster recalculation of audio waveforms
- Faster session save times
- Improved browsing of MXF audio files in the Project Browser

When Right-clicking a region for the first time, it was not possible to cancel metadata scanning, preventing the user from doing anything else in the session. (PTSW-57282, PTSW-135724)

Now, searching for channel match metadata occurs in the background. Right-clicking a region for the first time will display a “Searching for Metadata in the Background” message if the search takes more than 0.5 seconds. When the search is completed in the background, Right-clicking the region again displays any matches.

If a multi-channel audio file was exported directly from the Media Composer bin (without being cut into a sequence first), Pro Tools would not import the second channel of the file, nor metadata from the second channel. (PTSW-134991)

Pro Tools now correctly imports the second channel of an audio file and its metadata.
When importing an AAF from an Avid video editing application into Pro Tools, there could be missing audio regions, gaps in the timeline, or regions at the wrong timecode location if the original sequence contained subclips. (PTSW-3257)

When importing an AAF into Pro Tools, clips or subclips do not disappear, get truncated, or get pushed out of sync.

Pro Tools doesn’t import audio handles from a Media Composer AAF exported from a sequence containing multiple frame rates. (PTSW-123947)

Audio handles are now imported from AAF exported from Media Composer.

Pro Tools was not correctly interpreting original time stamp for 23.98 fps files from Media Composer. (PTSW-136042)

Pro Tools was incorrectly interpreting original time stamp for 23.98 fps audio files, which were passed through Media Composer and then imported into Pro Tools via AAF, preventing finding field recorder matches. Pro Tools now correctly interprets the original time stamp for these files.

Pro Tools would incorrectly post a “Disk Allocation Has Changed” warning whenever importing AAF files. (PTSW-135167)

This warning does not appear when importing AAF files and the disk allocation has not changed.

Pro Tools would display incorrect Sound Roll metadata when importing an AAF linked to MXF media and consolidating on import. (PTSW-131650)

The Sound Roll field in Pro Tools Project Browser now shows correct metadata for AAF consolidated on import.

Pro Tools did not see the names of any missing plug-ins or post a warning dialog when importing an AAF from Media Composer that uses RTAS plug-ins not available on the Pro Tools system. (PTSW-133794)

Pro Tools now posts a warning dialog listing any missing plug-ins.

When expanding channels to new tracks/playlists, it was not possible to set match criteria (PTSW-136095)

Pro Tools 9.0.2 adds the following (for more information, see the Field Recorders chapter in the Pro Tools 9.0.2 Reference Guide):

- A new Match Criteria dialog for Field Recorder Channels allows you to configure which metadata Pro Tools uses to determine matches.
- Separate submenus, “Alternates” and “Field Recorder Channels,” are available when Right-clicking on a region or a selection on mono track:
  - To access the Alternates menu, Control-click (Windows) or Command-click (Mac) on a mono track with the Selector tool.
  - To access the Field Recorder Channels menu, Control-Alt-click (Windows) or Command-Option-click (Mac) on a mono track with the Selector tool.

When expanding Field Recorder Channels to new tracks, files are offset from the guide track if the timecode rate of the Avid sequence differs from the timecode rate of the raw field recorder files. (PTSW-3241, PTSW-135973)

It is common for production audio to be recorded at a frame rate that differs from the frame rate at which the video is edited. For example, production audio is recorded at 30 fps, and the Avid video project is edited at 23.976 fps. In this case, raw production audio files could be offset from the guide track when expanding to new tracks. This has been resolved.

When importing an AAF sequence that links to media created with Avid Airspeed, missing or offline media would not automatically relink. (PTSW-3238)

This situation would occur if the Media Composer editor edited and exported the AAF sequence to Pro Tools while the Airspeed capture was still in progress. Because Media Composer did not yet know the duration of the files which are still being captured, the audio files were stamped with a duration of 1 hour, even though they are shorter. Thus, Pro Tools was not able to automatically relink to the files because the duration did not match.

Pro Tools no longer uses duration as a match criteria when relinking to MXF files, allowing automatic relinking under these conditions.
QuickTime Workflows

When importing a QuickTime movie with multiple audio tracks into Pro Tools, selecting specific tracks in the Track Import Window for import did not import those tracks. (PTSW-122635)

Track selections made in the Import Sound Track dialog now import the specified tracks.

When importing a QuickTime movie with multiple audio tracks into Pro Tools, if the track being imported did not have channel assignments in QuickTime, audio would be time-compressed and mixed together on all tracks. (PTSW-122625)

If the channels in a multichannel QuickTime movie sound track are not assigned (or if all channels are all assigned to Mono), Pro Tools maps the channels based on their order in the imported track.

When attempting to import audio tracks from a QuickTime movie that is larger than 4 GB, the import tails and Pro Tools would post an error message. (PTSW-135943)

Pro Tools can now import audio tracks from QuickTime movies larger than 4 GB.

When bouncing to QuickTime Movie with Delay Compensation enabled, audio is 2 frames early. (PTSW-134906)

When bouncing to QuickTime Movie with Delay Compensation enabled, audio is correctly synchronized.

Synchronization and Machine Control

On a Pro Tools system using 9-pin serial Machine Control with a VTR connected but no tape inserted, it was not possible to punch in and out with QuickPunch using keyboard shortcuts. (PTSW-3115)

QuickPunch keyboard shortcuts now work correctly on systems using 9-pin serial machine control with a VTR connected but no tape inserted.

When stopping playback in Pro Tools with Video Satellite, Media Composer could stop 2 - 4 frames after the Pro Tools system, causing the counters to be off. (Both systems were in sync during playback.) (PTSW-129926)

The timecode displays in Pro Tools and Media Composer now show the same value after stopping playback.

Avid Interplay

💡 To use Pro Tools 9.0.2 with Interplay, the Pro Tools Interplay Integration Plug-In version 2.4 or higher is required. To download the Pro Tools Interplay Integration Plug-In, visit www.avid.com.

When exporting selected tracks to Interplay, Pro Tools could only export to the original sequence from which it was created. If a newer version of the sequence existed, it was necessary to import the newer version to the session first before exporting to it. (PTSW-135233)

Pro Tools 9.0.2 can now export directly to alternate versions of a sequence on Interplay. To use Pro Tools 9.0.2 with Interplay, the Pro Tools Interplay Integration Plug-In version 2.4 or higher is required. To download the Pro Tools Interplay Integration Plug-In, visit www.avid.com.

When the Pro Tools/Interplay Import settings were configured, the Import Session Data dialog would not appear on import, which blocked the ability to use Match Tracks functionality, and in Pro Tools 9, the ability to choose which color Locators are imported. (PTSW-133110)

With the Pro Tools Interplay Integration plug-in v2.3 and higher, there is now a new “Show Import Session Data Dialog on Import” check box in the Interplay Import settings.

Importing a sequence from Interplay on Mac did not prompt user to mount missing ISIS workspaces. (PTSW-135006)

When importing a sequence from Interplay on Mac, Pro Tools prompts the user with a message informing them which ISIS workspaces need to be mounted.
If the destination Media Files folder on ISIS contained a large number of media files, Pro Tools could experience a potentially long “synchronizing” task in the Task Manager when exporting to Avid Interplay. (PTSW-134854)

Exporting to Avid Interplay has been optimized to reduce the time needed to synchronize in the Task Manager.

Pro Tools 9 could hang when exporting a sequence to Avid Interplay if the session had been closed and then reopened. This would only occur if Pro Tools was not already logged into Interplay prior to exporting. (PTSW-135046)

The Avid Interplay login screen appears and the sequence can be exported.

When exporting a sequence to Interplay, if there was a mismatch between the session start time and the sequence start time, and Link Edit and Track Selection was enabled, all tracks would become selected and exported whenever the start time was adjusted. This prevented selection of individual tracks for export. (PTSW-3226)

It is now possible to select and export individual tracks in a sequence to Interplay when a mismatch between the session start time and the sequence start time exists and Link Edit and Track Selection is enabled.

When importing a sequence into Pro Tools from Avid Interplay, the session would not import when importing into a new session based on a template. This would only occur if no session was open at the beginning of the import. (PTSW-3260)

It is now possible to import a sequence into a new session based on a template.

When importing a sequence from Interplay on Mac, the Pro Tools splash screen and a second instance of the Pro Tools dock icon would appear. (PTSW-135004)

The Pro Tools splash screen and icon do not appear when importing a sequence from Interplay.

**Audio Interfaces**

A footswitch does not work with Mbox Pro. (PTSW-135397)

A footswitch now works correctly with Mbox Pro. The Hardware Setup dialog for the Mbox Pro allows selection of Record Punch In/Punch Out or Playback Start/Stop functionality.

In Pro Tools systems with two MADI interfaces connected to a VENUE system, the 2nd MADI interface needed to be named (for example, MADI2) in I/O setups for tracks to be created in Pro Tools when doing VENUE Interop workflows, otherwise no tracks would be created for the 2nd MADI interface. (PTSW-134973)

The 2nd MADI interface no longer needs to be named for tracks to be created in Pro Tools under these conditions.

Low-latency monitoring with 003, 002, Mbox 2 Pro, Mbox 3 Pro and Mbox 3 was working only on Audio tracks, and not functional on Auxiliary Input or Instrument tracks. (PTSW-135127)

Low-latency monitoring now properly allows audio signals to pass through Audio, Auxiliary Input and Instrument tracks.

**Bounce to Disk**

When using the “Export Regions as Files” or “Bounce to Disk” command with a greater-than-stereo region or selection (such as on a 5.1 track), the choices were “Multiple Mono” and “Stereo Interleaved.” “Stereo Interleaved” did not accurately describe the greater-than-stereo status of the multichannel output file. (PTSW-57299)

The “Export Regions as Files” and “Bounce to Disk” commands now display the choice as “Interleaved” to indicate the greater-than-stereo status of the multichannel output file.

When using the Bounce to Disk command, it was not possible to bounce multiple tracks mapped to a single output path. (PTSW-134750)

In the Bounce to Disk dialog, a new physical outputs option has been added to the Bounce Source pop-up menu. The physical outputs option lists all available output paths as configured in the output pane of the IO Setup dialog. When you choose a physical output option as the Bounce Source, audio signals from all bus paths assigned to that physical output are included in the bounced file(s).
When bouncing to disk with Delay Compensation enabled, the audio was up to 50 samples early when the bounced audio was reimported into Pro Tools. (PTSW-134133)

When bouncing to disk with Delay Compensation enabled, bounced audio is correctly synchronized when reimported into Pro Tools.

When bouncing audio to MP3 format, it was not possible to bounce to multiple mono files. (PTSW-16793)

It is now possible to bounce multichannel sources to multiple mono MP3 files.

When bouncing to MP3 format, it is now possible to create a surround-encoded MP3 file by selecting the Enable MP3 Surround Encoding option in MP3 dialog.

This option is available only when bouncing stereo output to an interleaved MP3 file. The stereo output is upmixed and encoded to a 5.1-channel surround MP3 file that is also compatible with stereo MP3 playback.
Issues Resolved in Pro Tools 9.0.1

This section lists the issues resolved in Pro Tools 9.0.1 and Pro Tools HD 9.0.1.

The Pro Tools 9.0 installer replaced a previously installed Structure Full plug-in with Structure Free and deleted the Structure library. (PTSW-134827, PTSW-134887)

The Pro Tools installer now leaves any previously installed Structure Full plug-in untouched and does not replace it with Structure Free. If you already installed Pro Tools 9.0, you will need to reinstall Structure Full to replace Structure Free.

VocALign plug-ins could not process audio, and generated DAE error -7450 or displayed a warning dialog. (PTSW-133260)


EUCON-capable controllers using EUCON 2.5.6 did not punch in or out when in QuickPunch mode in Pro Tools 9. (PTSW-134916)

QuickPunch now punches in and out correctly with EUCON-capable controllers.

Pro Tools 9.0 was unable to update the firmware for any Avid/Digidesign Ethernet-based controllers, such as C|24, D-Command, and D-Control. (PTSW-134903)

Firmware can now be updated on Avid/Digidesign Ethernet controllers.

Pro Tools 8.0.4 and higher sessions would present an incorrect “Missing Files...” or “Some Regions had Invalid Bounds...” warning when you undo certain commands that remove audio files, save the session, and then open the session again. (PTSW-129321, PTSW-131342)

In Pro Tools 9.0.1 and higher, saved sessions no longer retain references to removed files. (Note: This may not fix sessions created with versions lower than Pro Tools 9.0.1 that present similar warnings.)

The cooling fan of the HD OMNI interface would produce excessive noise after a few minutes under certain conditions. (PTSW-130263)

The DigiTest firmware update for HD OMNI (v.2.10) includes a new cooling algorithm that improves some user’s experience of fan noise without sacrificing cooling performance. To update HD OMNI firmware, run the DigiTest application with HD OMNI connected to your system.

WAV files larger than 4 GB in the Pro Tools Workspace browser caused the audio files to be truncated. (PTSW-128581)

Files larger than 4 GB are no longer truncated when previewed in the Workspace browser.

These files can be previewed and imported into Pro Tools; however, any files with non-standard header formats (created with applications such as Nuendo) inaccurately report the file size, and only the reported file size will be previewed/imported. For example, a 4 GB file may have header information stating the file is only 200 MB, so you can only preview/import 200 MB worth of data from the file. To import the full 4GB file, it is necessary to re-export the file from the application (Nuendo) as a standard .BWF wave file and split the file into two 2GB files while exporting.
Known Issues in Pro Tools 9.0.6 on Mac OS X 10.7.x (“Lion”)

This section lists known issues in Pro Tools 9.0.6 and Pro Tools HD 9.0.6 for Mac OS X 10.7.x (Lion) only, and provides workarounds where they are available.

**Upgrading to Lion can result in the uninstallation of Pro Tools components for Digi 002 and 003 family systems.**

If you upgrade from Mac OS X 10.6.x (“Snow Leopard”) to Mac OS X 10.7.x (“Lion”) with Pro Tools already installed, *DigiDioMIDIServer.plugin* and *DigidesignFireWireMIDI.plugin* will be uninstalled during the Lion install. When the OS upgrade is complete, a dialog will appear indicating that these files were moved to an Incompatible Software folder. You can reinstall the drivers for your Digi 002 or 003 family interface after installation to restore these files.

To run Pro Tools on Mac OS X 10.7.x (“Lion”) with a Digi 002 or 003 family interface, Avid recommends that you create a clean Lion partition and install Pro Tools directly to that partition.

**Core Audio Manager quits unexpectedly with Digi 002 or 003 family interfaces.**

When using Core Audio Manager with a Digi 002 or 003 family interface (for example, to stream audio from the Web), Core Audio Manager can quit unexpectedly. When this occurs, quit any open applications and restart your computer; then try starting Core Audio Manager before launching any Core Audio-compatible audio application.

**Mac OS X 10.7.x keyboard shortcuts for Mission Control conflict with Pro Tools keyboard shortcuts.**

By default, Mac OS X 10.7.x uses Control + Arrow Up and Arrow Down keys to open Mission Control and Application windows. These keyboard shortcuts conflict with the Pro Tools keyboard shortcuts for changing track display height. You can disable or reassign these shortcuts in Mac OS X.

**To disable or reassign keyboard shortcuts in Mac OS X:**

1. From the Apple menu, choose System Preferences.
2. Click Keyboard.
3. Click the Keyboard Shortcuts tab.
4. Disable or reassign the shortcut for Mission Control.

**The Send To DigiDelivery command in Pro Tools will not work with Mac OS X 10.7.x (“Lion”).**

The DigiDelivery client application requires Rosetta to be installed. Mac OS X 10.7.x does not support Rosetta. The Send to DigiDelivery command in Pro Tools will not function on Lion.

**When using Aggregate I/O, a New Session command results in an error (PTSW-142151) or the Aggregate I/O Sample Rate is frozen at a setting of 0 Hz (PTSW-142166).**

If either of these errors occurs, do the following:

1. Quit Pro Tools.
2. Launch Audio MIDI Setup.
3. Choose Window > Show Audio Window.
4. Select Pro Tools Aggregate I/O.
5. Click the Minus sign icon to delete Aggregate I/O.
**Custom location for Creative Collection content is not remembered. (PTSW-146132)**

When installing Pro Tools, if you choose a custom location for Creative Collection content, that location is not remembered, resulting in error messages when you try to use a virtual instrument plug-in (Boom, Mini Grand, or Xpand) that references a “.big” content file. The location is not remembered after quitting and relaunching Pro Tools.

To avoid this error, move or reinstall the Creative Collection content to the default location in the Applications > Digidesign folder.

**In Mac OS X 10.7.x, the Library folder in each User folder is now hidden.**

DigiTrace logs, which can be helpful in troubleshooting Pro Tools errors, are stored in User/Library. These logs will be more difficult to find if the Library folder is hidden.

To find the Library folder:

Go to the Finder and click the Go menu while holding the Option key. Library will appear in the menu while the Option key is held.

**To permanently unhide the Library folder:**

1. Launch Terminal.
2. Type: `chflags nohidden /Users/<Username>/Library`.

💡 The hide status of the Library folder may be reset during an OS update.

---

**Known Issues in Pro Tools 9.0.6 (All Mac OS X Systems)**

The following section documents known issues you may encounter when using Pro Tools 9.0.6 and Pro Tools HD 9.0.6, along with workarounds if they exist.

For known issues specific to any of the software options for Pro Tools HD, see the Satellite Link Read Me, the Video Satellite Read Me, or the Video Satellite LE Read Me.

For known issues specific to the Complete Production Toolkit 2 option for Pro Tools, see the Complete Production Toolkit 2 Read Me.

**General Pro Tools Issues**

Playback of QuickTime video in Pro Tools may stutter or drop frames.

When monitoring QuickTime playback in the Pro Tools Video Window on the computer screen, the video image may stutter or drop frames. To improve results with QuickTime playback, try any of the following:

- Disable Continuous Scrolling.
- Close unnecessary UI windows.
- Try using the DNxHD codec.
- If you have an available PCIe slot in your computer, try using one of the following:
  - A supported Blackmagic video card
  - A supported Canopus video peripheral for QuickTime DV playback
- Consider using an Avid option that includes a video solution:
  - The Video Satellite option offers guaranteed performance for Avid video playback (QuickTime can also be used via AMA).
  - The Video Satellite LE option offers a way to integrate a Blackmagic video card into a system
  - The Avid Mojo SDI peripheral offers guaranteed performance for standard-definition Avid video
Synchronizing to External Clock with a Different Sample Rate from the Session Results in the Following Error: “The current playback engine does not support a sample rate of 44.1 kHz” (PTSW-127065)

In certain circumstances, attempting to synchronize to an external clock that has a different sample rate than the session may result in the following error: “The current playback engine does not support a sample rate of 44.1 kHz.” On Mac OS X, this may be preceded by the error “Pro Tools has re-set the sample rate of the HW device because it was changed by another application.” If this happens, correct the sample rate mismatch and re-select the correct clock rate.

Templates Retain I/O Settings and Some Preferences, Display Settings, and Window Layouts (PTSW-47133)

Pro Tools Session Templates Retain the I/O settings and some of the preferences, display settings, and window layouts from the system on which the template was created. Consequently, created a new session based on a template restores several session properties from the original system. These properties are retained by Pro Tools until you change them or another session or template is opened that replaces them. This also means that if a new blank session is created after using a template, the properties from the template will be used for the new session.

The properties retained from templates include default track height, view settings, window size and position, and I/O Setup. You can update templates by making the desired changes, using the File > Save as Template command (be sure to select the “Install template in system” option), and then selecting the template you want to replace.

CPU Usage Limit May Be Reached when Error Suppression is Enabled (PTSW-50339)

When enabling Error Suppression at CPU Usage Limit 85% or higher, it may be possible to overload your computer to a point at which it is no longer recoverable. To avoid this state, keep your CPU Usage Limit set to 80% or lower when Error Suppression is enabled.

Screen Redraw May Slow Down at Higher CPU Usage Limit Settings when RTAS Error Suppression is On (82915)

In some cases, you may experience a slowdown in screen redraw or background CPU tasks when RTAS Error Suppression is engaged and the CPU Usage Limit is set to 85 percent or above. If you encounter this behavior while using RTAS Error Suppression, open the Playback Engine Dialog and lower the CPU Usage Limit by 5 to 10 percent.

Opening Session Created with Pro Tools 7.4 or Lower (106746)

When opening sessions created with Pro Tools 7.4 or lower in Pro Tools 8.1 and higher, all waveform overviews are recalculated. This is because Pro Tools now features 16-bit waveform overviews, so all old 8-bit overviews will need to be recalculated. This recalculation only needs to happen once.

Automation Window Update when Writing Automation (PTSW-46747)

When writing automation on Volume, Pan, and so on, the corresponding buttons in the Automation window provide no indication that automation on the related control is being written. You will need to observe the automation buttons on tracks in Mix or Edit windows to see an indication that automation is being written.

Possible Performance Issues with Waveform Overviews (110041, 106801, and 106577)

Calculating waveform overviews in Pro Tools 8.1 and higher may cause some one time issues with various operations. Once the overviews are calculated, system performance will return to normal. Areas where you may notice this are:

- Legacy Sessions (110041)—When opening Legacy Pro Tools sessions (lower than 8.0) for the first time, if you immediately start playback, you may encounter various errors advising you to increase the H/W Buffer size, or to delete tracks, or to remove some RTAS plug-ins. This is due to the fact that Pro Tools is re-calculating the session’s waveform overviews in the background. Pausing this task in task manager, or waiting until this task is complete, will resolve the issue. Once the waveform is calculated, you will not experience this issue again.

- Playback of Newly Created Regions (106801 and 106577)—You may notice a slight drop in normal playback performance immediately following a record take or after creating or importing new regions. This is due to the fact that Pro Tools is calculating waveform overviews in the background, and is mostly only encountered when recording or creating many regions with long durations. Pausing this task in task manager, or waiting until this task is complete, will resolve the issue. Once the waveform is calculated, your session playback performance will return to expected levels.
Audio Regions on Tick-Based Tracks Do Not Play at the Correct Tempo after Opening a Reason Song with a Different Tempo (PTSW-34086)

Audio regions on tick-based tracks do not play at the correct tempo after opening a Reason song with a tempo that is different from the one in your session. To correct this, make any tempo change via the Conductor track or the Manual Tempo input and the regions will play back correctly.

Cannot Run Reason or Record as ReWire Clients if They Have Not First Been Launched and Set Up as a Standalone Application (PTSW-133070)

Reason and Record need to be launched and setup as a stand-alone applications before running them as a ReWire clients with Pro Tools. Do the following:

- Launch Reason or Record in stand-alone mode and follow the on-screen instructions.
- Quit Reason or Record.
- Launch Pro Tools and insert Reason or Record as a ReWire plug-in on an audio, Auxiliary Input, or Instrument track.

Import Audio Incorrectly Splits a Stereo Interleaved WAV file that contains IXML Metadata into Two Separate Mono Tracks (98841)

Import Audio incorrectly splits a stereo interleaved WAV file that contains IXML metadata into two separate mono tracks. Please use the workspace instead to drag the file into the Edit window or directly onto a stereo track.

Opening a Session with a QuickTime Movie as a Non-Administrator User Can Prevent the Movie from Playing Back (47053)

If you open a session as a non-administrator user and you do not have permissions for the QuickTime movie file, Pro Tools will tell you that the movie file cannot be found and prompt you to relink. In the relink window the movie can be found and Pro Tools will appear to relink to it but it will still not play back. For correct playback, make sure you have permission to use the QuickTime movie file.

Some QuickTime Audio Formats Cannot Be Imported (58792 and PTSW-52226)

The audio from QuickTime movies with Apple Lossless or AMR audio compression cannot be imported into Pro Tools. Use QuickTime Pro or another application to convert the audio to another format prior to import.

Apple Lossless Codec Is Not Supported for Bounce to QuickTime Movie (PTSW-53198)

Pro Tools 7.3 and higher does not support the Apple Lossless audio codec. Choosing it from the Bounce to QuickTime Movie Audio Compression dialog will result in a movie without usable audio.

48 kHz Bounce to MP3 in Pro Tools 7.x and Higher Results in a 44.1 kHz MP3 File (72617)

Bouncing to MP3 while using the “Highest Quality Encoding, Slower Encoding Time” setting with any bit rate other than 320kbps will result in a 44.1kHz file. This is a known limitation of the encoder.

Hourly –9073 Errors During Recording (PTSW-132654)

If you encounter –9073 disk errors at the same time every hour while recording in sessions with large track counts, you may need to update Mac OS. To avoid this problem, check and install all OS related security updates through Mac Software Update.

Pro Tools|HD Systems

Unable to Open Sessions Created with Pro Tools 7.4 or Lower that Use the Maximum Available DSP in Pro Tools 8.1 and Higher (111490)

Since the surround mixer plug-in is installed by default with Pro Tools 8.1 and higher, some stereo sessions that use mono output paths may use a different DSP allocation than in Pro Tools 7.4 and lower. Older sessions that use mono output paths and use all of the available DSP and may not open in Pro Tools 8.1 or higher. The workaround is to remove the surround mixer plug-in from the “Plug-Ins” folder and move it to the “Plug-ins (Unused)” folder so Pro Tools does not use the surround mixer to build your mixer. This should make the necessary DSP available to open the session.
Pro Tools|HD Native Systems

Audible Pops and Clicks when Changing Buffer Sizes (PTSW-125715)

Pops and clicks may occur when changing the Hardware Buffer Size (H/W Buffer Size) in the Playback Engine dialog while monitoring live audio through Pro Tools|HD Native hardware. Avid recommends not changing the Hardware Buffer Size while monitoring live audio to avoid this problem. If you must change the Hardware Buffer Size while monitoring live audio, be sure to lower the monitoring volume to avoid any possible damage to your speakers.

I/O Setup

Session Templates Retain I/O Settings and Some Preferences, Display Settings, and Window Layouts (111605)

Pro Tools Session Templates retain the I/O settings and some of the preferences, display settings, and window layouts from the system on which the template was created. Consequently, creating a new session based on a template restores several session properties from the original system. These properties are retained by Pro Tools until you change them or another session or template is opened that replaces them. This also means that if a new blank session is created after using a template, the properties from the template will be used for the new session.

The properties retained from templates include default track height, view settings, window size and position, and I/O Setup. You can update templates by making the desired changes, using the File > Save as Template command (be sure to select the “Install template in system” option), and then selecting the template you want to replace.

Opening a Pro Tools 8.1 or Higher Session in a Lower Version of Pro Tools, Saving It, and then Re-opening it in Pro Tools 8.1 or Higher Can Result in Duplicate Output Paths (PTSW-127380)

When exchanging sessions between systems with different hardware configurations, it is possible to encounter duplicate Output paths. For example, when opening a session created in Pro Tools 8.1 or higher with an HD OMNI in a version of Pro Tools lower than 8.1, saving it, and then opening the session in Pro Tools 8.1 or higher, the Monitor Output path may be duplicated with “.1” or “(1)” appended to the name of the duplicate path. You can manually delete unwanted paths.

When Opening a Pro Tools 8.1 or Higher Session in a Lower Version of Pro Tools, Overlapping Output Paths May Appear Inactive (PTSW-128064)

If a session is created in Pro Tools 8.1 or higher that contains overlapping output paths where a smaller Path appears below a larger path in the Output page of the I/O Setup, the larger path will be made Inactive when opened in versions of Pro Tools lower than 8.1. However, if overlapping larger paths are created above smaller paths in the Output page of I/O Setup, the smaller paths appear as Sub-Paths of the larger path when opened into lower versions of Pro Tools.

Master Faders Assigned to Mapped Output Busses Function Only on that Specific Bus, Not for the Output Channel as a Whole (PTSW-127517)

Because a Master Fader works on a bus, not on an output path or output channel, there may be certain configurations in which the level sent to the physical I/O is not reflected on any meters in the Pro Tools application. If the configuration includes overlapping output paths or has multiple busses assigned to a single output path, the overall signal level from these combined sources (including any clipping indication) will only be displayed on the interface itself. You can avoid using multiple output paths or output busses simultaneously by routing your sources to a single mapped output bus and assign a Master Fader to that.

Overlapping Outputs Are Not Supported for AFL/PFL (PTSW-128167)

While Pro Tools I/O Setup lets you select overlapping outputs for AFL/PFL monitoring, overlapping outputs are not supported for AFL/PFL monitoring. For example, if paths A 3–4 overlap the main path A 1–2, even though you can select paths A 3–4 for AFL/PFL monitoring, you won’t hear anything when monitoring AFL/PFL on paths A 3–4. You can avoid this problem by using non-overlapping paths for AFL/PFL monitoring.
File and Disk Management

Missing Files when Opening a Session that Was Saved Using Save Copy In with Preserve Folder Hierarchy (PTSW-52860)

The Preserve Folder Hierarchy feature is designed so that sessions with media split between multiple volumes can be easily moved between systems while retaining folder hierarchy. In order for media files to be automatically found, manually copy or create a folder at the root level of each volume with the session name that contains the Audio Files or Video Files folder. Or, manually relink to the missing files at their current location.

Session Copy Saved with Preserve Folder Hierarchy in which Multiple Files Have the Same Name Does Not Relink Properly (PTSW-29069)

When saving a session copy with Preserve Folder Hierarchy checked, files with the same name may not relink properly when using Manual Relink. When opening the session copy, use Automatically Relink to locate the correct files. If the session has already been opened using Manual Relink and some files are still offline, select Relink Offline in the Project Browser to manually relink the remaining files.

Elastic Audio

Certain Audio Files Cannot Be Calculated or Cleared of Elastic Analysis in Workspace Browser (PTSW-29622)

There are some rare cases where a file will have a file suffix of a file format supported by Elastic Audio (either .WAV or .AIF), but the Pro Tools Workspace Browser will not allow calculation or clearing of elastic analysis. The browser menu items Calculate Elastic Analysis and Clear Elastic Analysis will be greyed out. In these cases, the file may actually be in a non-supported format. To check the file's format, look at the Format column in the Workspace browser. If a file format other than WAV or AIFF is shown (such as QuickTime), then the file cannot be calculated or cleared of elastic analysis. Note that these non-supported files can still be previewed in tempo, as well as elasticized once imported into a session.

Tempo Maps Made from Bar|Beat Marker Generation in Beat Detective Cause Region Groups in Rendered Mode to Fall Offline (PTSW-34950)

A tempo map made from Bar|Beat Marker Generation in Beat Detective will cause region groups in Rendered mode to fall offline. The workaround is to make an edit to the offline region and then toggle the Elastic Audio from rendered to real-time and then back to rendered.

Maintaining Phase Coherency with Elastic Audio Pitch Processing (PTSW-20602)

When there is Elastic Audio Pitch processing enabled on a track, switching from Polyphonic, Rhythmic, or X-Form to Monophonic or Varispeed can disrupt phase coherency. To preserve phase coherency in this case, be sure to clear all Elastic Audio Pitch processing from the track before switching to the Monophonic or Varispeed algorithm.

Drift in an Audio File May Occur when Using Elastic Audio and the Monophonic or X-Form Algorithms (PTSW-33768)

Drift in an audio region may occur when using elastic audio depending on how much the regions is expanded or compressed when using the Monophonic or X-Form algorithms. If you are using elastic audio with material that contains transient information in it that you would like to keep from drifting, you should use the Polyphonic or Rhythmic algorithms.

Default Input Gain Preference Is Only for Elastic Audio Imported at Session Tempo (PTSW-34096)

The Default Input Gain preference in the Elastic Audio section of the Processing Preferences page is for Elastic Audio Imported at Session Tempo only. This preference option will not function unless Preview in Context is enabled in Workspace, and/or “Drag and Drop from Desktop Conforms To Session Tempo” is enabled in the Processing Preferences page.

Displayed Timebase is Incorrect after Importing Elastic Audio Tracks (PTSW-46897)

The incorrect timebase is displayed after importing Elastic Audio tracks to existing tracks with opposite timebase. You will need to manually select the correct timebase for the affected tracks.
Elastic Audio Regions on Playlist Lanes Are Not Rendered (PTSW-47311)
In Playlists View, any Elastic Audio regions on Playlist lanes are not rendered (waveform is “off-line”) when changing the track’s Elastic Audio processing from Real-Time to Rendered.

Region Groups Containing Elastic Audio Are Not Recognized as Elastic if the Region Group Itself Has Not Had Any Elastic Functions Applied (PTSW-34335)
If a region group contains Elastic Audio inside it, but no Elastic Audio operations have been performed on the outermost level of the region group itself, then the region group will not register as Elastic Audio. When used to create a new track, the track will not automatically be Elastic Audio-enabled, and the elastic audio inside the region group will be rendered using the default Elastic Audio plug-in for the session. As a workaround, add a warp marker to the region group to force it to register as an elastic region. Or, create an Elastic Audio-enabled track first, then add the region group to it.

Cannot Import Elastic Audio Tracks with the Consolidate From Source Media Option (PTSW-33894)
Use Copy from Source Media to import Elastic Audio tracks.

Timing Inaccuracy in Audio Files Converted from CAF and MP3 with Preview In Context Enabled (PTSW-46707)
Audio files converted from CAF and MP3 with Preview In Context enabled can cause timing inaccuracies (gaps in the audio and inner-region asynchronous transients issues). This is inherent with compressed file formats.

MIDI

When Recording MIDI, Wait for Note Does Not Respond to MIDI Input from ReWire (PTSW-30511 and PTSW-34550)
When performing a MIDI record, Wait for Note will not respond to any MIDI received from ReWire. If you are recording MIDI generated from a ReWire application, you will have to start the transport manually or use a countoff instead of Wait for Note.

When Using Import Session Data on a MIDI Track with Real-Time Properties Enabled and Set to Using Diatonic Transposition, Transposition is Based on the First Key Signature in the Session Only (PTSW-49297)
When importing session data from a session that includes multiple key signatures and a MIDI or Instrument track with the “Transpose in Key” Real-Time property enabled, the transposition will be based only on the first key in the session. This can be corrected by toggling the Real-Time Properties off and on; then the diatonic transposition will be correct for each key.

Plug-Ins

For known issues about specific plug-ins, see the Audio Plug-Ins Read Me.

If you install Pro Tools 9.0 on a clean Pro Tools system, and then run HD Pack, Mbox Factory, or 003 Factory plug-in installers included with lower versions of Pro Tools (such as Pro Tools 8.0.4), they will not be able to install the bundled plug-ins as you might expect. Visit the Avid website (www.avid.com) to download the latest versions of corresponding installers included with the version of HD Pack, Massive Pack, Mbox Factory, or 003 Factory that you own. These installers have been updated to run on a Pro Tools 9.0 system (as long as you have valid licences for each plug-in on your iLok).

Pro Tools Hangs when Opening a Session with Structure Free (PTSW-131965)
When opening a Pro Tools session that uses Structure Free, Pro Tools may hang temporarily if Structure Free is looking for files in a directory where the files are not present.

Pro Tools Quits Unexpectedly when Creating a New Folder on the Presets Page with Hybrid (PTSW-133279)
When using Hybrid version 1.5.3.10110, Pro Tools may quit unexpectedly when using the New Folder feature on the Presets page. To avoid this problem, update to the latest version of Hybrid.
**AudioSuite and Region Groups (PTSW-57457)**

AudioSuite plug-ins handle Region Groups in the Region List slightly differently than audio files. With audio files, an AudioSuite process can be applied to all copies of a unique audio file which appear in your session by selecting your target as Region List in the AudioSuite plug-in window and selecting Use in Playlist. However, if your target is set to Region List in the AudioSuite plug-in window while you have a Region Group selected, Pro Tools does not recognize the Region Group as processable audio and will present a No Audio was Selected error. This is because a Region Group is not treated as audio until it is actually used in a track.

**To apply an AudioSuite process to all copies of a Region Group in a session at once, do the following:**

1. Select the Region Group to be processed.
2. From the Region List menu, select Ungroup All. All elements of the group will remain selected.
3. Perform AudioSuite processing.
4. From the Region List menu, select Regroup.
5. When prompted, select Modify to apply the AudioSuite Process to all copies of the Region Group in the session, or Copy to apply it only to the selected Region Group.

**Plug-in Find and Relink with File Types not Supported by Pro Tools (111704)**

Find and Relink will not be triggered by plug-ins in situations where plug-ins supporting Find and Relink are missing links to file types that are not natively supported by Pro Tools (such as REX files). To have full Plug-in Find and Relink support, the file types used in plug-ins must also be supported by Pro Tools.

**Software Instrument Does Not Emit Sound when Inserted on an Instrument Track or Auxiliary Input (65797)**

Some older software instruments do not emit sound and/or do not play unless they have a valid hardware input or MIDI output assignment. If this problem occurs, manually assign a hardware input to the Instrument track or Auxiliary Input, and/or manually assign a MIDI output to the Instrument.

**Pro Tools Quits Unexpectedly when Canceling BX Digital PACE Authorization (PTSW-132311)**

If Pro Tools quits unexpectedly when canceling the PACE authorization for BX Digital plug-ins, be sure to install the latest iLok driver (even if the driver is already installed). This should correct the problem.

**Control Surfaces**

**Trim Scrub and Trim Shuttle Don’t Work on Regions with Fades (PTSW-46911)**

If a region has fades, Trim Scrub and Trim Shuttle don’t work when trying to trim using a control surface. To work around this problem, remove any fades on the region, then execute the Trim Scrub or Trim Shuttle, and then restore the fades.

**Used HW Output Path Indication (101095)**

In Assign Matrix on your worksurface, Insert mode the used HW output path will not have amber background indicating that it’s already assigned after switching to a different insert on the same track.

**Color Indication on Plug-in Controls in Learn Mode (102710)**

When a plug-in is in Learn mode and the track with this plug-in is not focused on the main ICON unit, all automation LEDs in the Plug-in window will be red if the track is in one of auto write modes. This conflicts with red color indication on the Plug-in control, which is armed for mapping. The workaround is to set the track with plug-ins to Read automation mode.

**SignalTools Meter Ballistics on Control Surfaces (74340)**

SignalTools RMS, VU, BBC, Nordic and DIN meters will display inaccurate decay times when viewed on a control surface. Unaffected types are Peak, VENUE, and Peak + RMS, which only reports the Peak meter to the control surface. The attack times of the affected meters are not affected, only the decay times. All meter types display accurately in the plug-in window.
Pro Tools Transport Must Be Stopped when Recalibrating ICON Faders (78074)

The transport in Pro Tools must be stopped when recalibrating faders on D-Command and D-Control. If one or more faders need calibration do the following: Stop playback, enter Utility mode, press TEST, press FAADER, and press RECAL. After recalibrating faders, exit Utility mode.

The Edit and Mix Window Do Not Follow Banking on EUCON Control Surfaces (PTSW-133466)

When the Edit Window follows Bank Selection and/or the Mix Window follows Bank Selection preferences are enabled in Pro Tools (Setup > Preferences > Mixing), after banking your EUCON controller, neither the Edit nor Mix window scroll to follow. You will have to manually change the view of the Edit or Mix windows to see the tracks that correspond to the EUCON controller if they are off screen.

Synchronization and Machine Control

When controlling a system in Remote mode with a 9-pin controller, while playing back a session, quickly pressing Stop and Play again will generate a warning message. (PTSW-154518)

When using a 9-pin controller with Pro Tools in Remote mode, pressing Play, Stop and Play in quick succession (or during playback, pressing Stop and Play in succession) may cause Pro Tools to post a warning. If this occurs, stop playback, close the warning, and resume playback.

When controlling a system in Remote mode with a 9-pin controller, issuing a Locate and Rollback command moves the transport to the correct location but blocks play commands to Pro Tools. (PTSW-154462)

When using a 9-pin controller with Pro Tools in Remote mode, the Locate and Rollback command does not initiate playback correctly.

When using the Colin Broad model SR-4 9-pin controller, Reverse Playback does not function. (PTSW-154441)

The Reverse Playback feature on the Colin Broad SR-4 is not recognized by Pro Tools.

Video

When Using the Avid Video Engine, Pro Tools 9.0 Cannot be Co-Installed with Media Composer 5.0 and previous (PTSW-132945)

When using the Avid video engine with Pro Tools 9.0, you cannot co-install Avid Media Composer 5.0 and lower on the same computer. If the Avid video engine is not installed, older versions of Media Composer (such as v5.0) can be used. Pro Tools 9.0 can be co-installed with Media Composer 5.5 and higher.

Avid Video Peripherals Are Not Officially Supported with Pro Tools Software (PTSW-132918)

When using an Avid video peripheral such as Mojo SDI with Pro Tools, you must have Pro Tools|HD or Pro Tools|HD Native hardware with a SYNC HD or SYNC IO in order to maintain near sample accurate audio/video sync. Alternately, Pro Tools LE hardware containing an S/PDIF input can be used to resolve the audio clock to the video peripheral. While it is possible to use an Avid video peripheral without the presence of any hardware (Pro Tools Software only), audio/video sync is not guaranteed.

Video Offset Affects Bounce To QuickTime Files (PTSW-123033)

If Pro Tools has a defined Video Offset and you Bounce to QuickTime, the resultant QuickTime file will be offset by the specified amount in Pro Tools (Setup > Video Sync Offset). To avoid this problem, set the Video Sync Offset to 0 before bouncing to the QuickTime file format.

When Using Bounce to QuickTime, Do Not Bounce to an Existing Movie Name (PTSW-53967)

If you use the Bounce to QuickTime command and use the same name as an existing movie, the bounce may fail. It is best to use a unique name for each bounce, or delete the previous movie from the drive prior to bouncing with the same name (rather than choosing to replace the existing file).
Pro Tools UI May Slow Down with Densely Edited QuickTime Movie Track (PTSW-54496)

Pro Tools may begin to respond more slowly and update less often as a session with one or more QuickTime video tracks becomes more and more densely edited. If, while working with heavily edited QuickTime clips, Pro Tools responsiveness begins to decline, use the Bounce to QuickTime Video command, then import the bounced movie.

Unsupported QuickTime Video Formats (PTSW-52140, PTSW-52155, PTSW-52156, 72961)

Several video formats supported in QuickTime are not supported in Pro Tools. These include .DivX, .flc, .m4v and .3gp format movies. Attempting to import these will generate errors or will fail to import.

Standard Definition QuickTime Movies Are Rendered as 16:9 Anamorphic Play Back in Pro Tools at 4:3 (PTSW-23020)

Standard Definition QuickTime movies rendered with 16:9 an anamorphic Scaled Size of 853x480 play back in Pro Tools at 4:3 or 720x486 resolution. The Scaled Size attribute of QuickTime movies is ignored by Pro Tools. To work around this problem, render the movie letterbox natively within the 720x486 pixel dimension.

MPEG-1 and MPEG-2 Video Freezes at Edit Points (PTSW-55185)

Editing MPEG-1 & MPEG-2 video is not officially supported. If you experience this problem, try switching playback to the Video window, or convert the movie to a supported format using a 3rd party application. Removing the audio from an MPEG-1 or MPEG-2 movie with a 3rd party application may also fix the problem.

Audio from “Muxed” MPEG-1 and MPEG-2 Movies Cannot Be Imported and Will Be Heard in a Bounced Movie (PTSW-53625)

Unlike other QuickTime formats, MPEG-1 and MPEG-2 movies store audio and video in a single multiplexed track, called a “muxed.” track. Pro Tools cannot separate the audio from video for these types of movies. As a result, you will not be able to import the audio from an MPEG-1 or MPEG-2 movie. Also, if you Bounce to QuickTime using an MPEG-1 or MPEG-2 movie as a source movie, the original audio from the movie will be present in the bounced movie (even though it will not be heard while working with the movie in Pro Tools). To import audio from an MPEG-1 or MPEG-2 file, use a third party application to “demux” the MPEG stream.

Dragging from Mac Finder in Shuffle Mode Does Not Work Correctly with Video (PTSW-28041)

Dragging a Video file from the desktop to the Edit window while in Shuffle mode will always place the video at session start, overwriting existing video regions in that location.

System Instability when Running Multiple Applications Using Blackmagic Design Hardware for QuickTime Video Output (PTSW-19486)

When Pro Tools is running with a Blackmagic DeckLink II Extreme or Intensity video capture and playback PCI-e card installed, launching Blackmagic Design’s Deck Capture utility, Final Cut Studio, or any other application which supports Black Magic hardware for video output, can result in system instability. To avoid any potential system instability only use one Blackmagic DeckLink–aware application at a time.

Performance Issue with BlackMagic QuickTime Playback Card on Mac OS 10.6–10.6.2 with a “Harpertown” and Previous Generation Mac Pros (120184)

When using a Blackmagic Quicktime playback card (Decklink or Intensity) on “Harpertown” and previous Mac Pros with Mac OS 10.6–10.6.2, the video output may drop frames at certain frame rates. To avoid this issue, use Mac OS 10.6.3 or Mac OS 10.5.8 (Leopard). This issue does not occur with the newer “Nehalem” Mac Pros.

Region names appear incorrect after selecting Field Recorder channel matches, or expanding to new tracks. (PTSW-136012)

This can occur if the file name of a Field Recorder channel match contains a hyphen followed by a number greater than zero. Pro Tools names new regions by incrementing the number after the hyphen. If a field record file is already named in this way (such as “Filename-01”), then new regions created by selecting a Field Recorder channel match or by expanding a track may have names different from the parent file. To avoid this situation, avoid using hyphens in Field Recorder file names.
General Localization

Session Notes or Session Info Text Files Saved in Japanese May Not Open in TextEdit (PTSW-46686)

Session Notes (you can generate these if you are missing plug-ins or have problems when opening a session) or Session Info (File > Export > Session Info as Text) text files may not open in TextEdit, depending on the TextEdit preference settings. This is because the files use different text encoding. As a workaround, you can use the Console application to open files or you can use the Open menu item in TextEdit, then choose the correct encoding, as follows:

- Session Notes - UTF-8
- Session Info - Japanese (Mac OS)

Certain Chinese Characters Need to Be Initiated in the Mac OS Before They Can Be Used for Naming in Pro Tools (PTSW-33074)

If you cannot use certain characters for naming in Pro Tools, use Text Edit in Mac OS X to initiate the characters. In Text Edit, type the same characters you were trying to use, then use the mouse to select the correct ones from the pop up menu. You should now be able to use them in Pro Tools.

AAF/OMF Sequences with Non-English Characters Import with Garbled Region Names or Won’t Relink (PTSW-33569, PTSW-99570, PTSW-33826)

If an AAF/OMF sequence containing files or region names with non-English characters is exported from a Mac-based Pro Tools 7.3.1 system (or lower), it may not import correctly into Avid Media Composer, or Pro Tools 7.4 and higher systems on Windows or Mac. Conversely, AAF/OMF sequences with non-English characters exported from any Pro Tools 7.4 or higher system (or higher) may not import correctly into a Mac-based Pro Tools 7.3.1 (or lower) system. To relink the files, select “Manually Find and Relink,” then deselect all options except “Find by file ID.” Region names may appear garbled.

Known Issues with Pro Tools CoreAudio Hardware Drivers

Limitations of the Avid CoreAudio Driver with Digi CoreAudio Manager

The Digi CoreAudio Driver has the following limitations with HD, 003, and Digi 002 systems:

- Pro Tools HD, and Pro Tools with 003 and Digi 002 systems require exclusive access to Pro Tools hardware. You cannot use CoreAudio applications and Pro Tools with these systems at the same time. To use Pro Tools, make sure you quit any CoreAudio applications before launching Pro Tools on these systems. To use a CoreAudio application with these systems, make sure you quit Pro Tools before starting the CoreAudio application.

- The Digi CoreAudio Driver cannot be used to preview sound files from the Mac Finder while Pro Tools is running. When a sound file is located in the Mac OS X navigation window, a QuickTime transport bar is displayed next to it. The QuickTime transport bar lets you audition the sound file. With USB audio interfaces, you can preview sound files from the Mac Finder as long as Pro Tools is not running. Regardless, with FireWire and Pro Tools|HD audio interfaces, the sound will always play back through the Mac built-in audio controller (through the Mac speaker or headphone jack). However, if you double-click a sound file, the QuickTime application will launch, which can use the Digi CoreAudio Driver for playback.

- The Digi CoreAudio Driver cannot be used for playback of Mac System Sounds.

Selecting “Digidesign HW” for Sound Input or Output in System Preferences May Cause Pro Tools to Fail to Launch (99576)

If “Digidesign HW” is selected as the input or output device in System Preferences, certain common actions in the Finder may activate the Digi CoreAudio Manager. These actions include selecting an audio or video file while in Columns view or while the Inspector window is open, or using Get Info or Quick Look on an audio or video file. Once activated, CoreAudio may remain connected even after selecting a different file or closing all Finder windows. If Pro Tools is launched while CoreAudio is connected, an error message stating “Digidesign Hardware is in use by another application. (–1133)” may occur.

Pops when Changing Sample Rates

With the Digi CoreAudio Manager, your Pro Tools hardware may produce a “pop” or “click” sound if Pro Tools was last used at a sample rate different from the one the new CoreAudio client is set to use.
Pro Tools Hardware May Not Play Sound from QuickTime or Safari with CoreAudio (PTSW-3093 and PTSW-27892)

If you do not hear sound when playing back audio through Pro Tools hardware from QuickTime or Safari with the Digi Core-Audio Manager, try one the following:

- Open the Mac System Preferences and click Sound. While QuickTime or Safari is playing back audio, change the Output from Digidesign HW to Internal, and then back to Digidesign HW.
- or –
- Launch iTunes before launching QuickTime or Safari.

Buffer Sizes Incompatible with Pro Tools Hardware (39542)

In Cubase, Traktor, Live, and certain other applications, you can select Buffer Sizes that may be incompatible with your Pro Tools hardware. Selecting incompatible buffer sizes results in distorted sound and may cause other problems. Please make sure to select Buffer Sizes listed in the following chart:

<table>
<thead>
<tr>
<th>Cubase SX Buffer Sizes Supported by Digidesign Hardware</th>
</tr>
</thead>
<tbody>
<tr>
<td>Digidesign Hardware</td>
</tr>
<tr>
<td>Pro Tools</td>
</tr>
<tr>
<td>Pro Tools</td>
</tr>
<tr>
<td>003, 003 Rack, 003 Rack+, Eleven Rack, Digi 002, and Digi 002 Rack</td>
</tr>
<tr>
<td>Mbox and Mbox 2-series interfaces</td>
</tr>
</tbody>
</table>

Reason Output Distorts with Buffer Size Settings Less than 256 Samples, at 88.2 kHz or 96 kHz (39399)

Distorted sound can result when a Reason user has selected a Buffer Size of less than 256 samples at sample rates of 88.2 kHz or 96 kHz.

Known Issues with Audio Interfaces

HD OMNI

Noise in the Output Signal from HD OMNI with Digital Input (PTSW-1614)

If HD OMNI is connected to a digital source with a mismatched clock and Sample Rate Conversion (SRC) is not enabled, you will hear noise (including loud “pops”) in the output signal. To correct this problem, either enable SRC or ensure that the clock of the digital source and HD OMNI are matched correctly.

HD OMNI Front Panel SETUP Menus are Unresponsive after Pro Tools Quits Unexpectedly (PTSW-125692)

HD OMNI will not automatically recover “stand-alone” mode if Pro Tools quits unexpectedly (or if you disconnect the DigiLink cable from HD OMNI while Pro Tools is running). As a result, some of the SETUP functions accessible from the front panel will be unavailable. Power cycle HD OMNI to recover stand-alone mode.

Graphic Redraw Problems in the Hardware Setup Dialog (PTSW-122690, PTSW-1346, and PTSW-1235)

When changing the Hardware Setup configuration for HD OMNI, it is possible to encounter graphics redraw problems in some cases. To force a graphics redraw of the Hardware Setup dialog, close and reopen the Hardware Setup dialog.

Versions of Pro Tools Lower than 8.1 Quit on Launch with HD OMNI (PTSW-1976)

When launching versions of Pro Tools lower than 8.1 with HD OMNI connected and powered on, Pro Tools quits when initializing DSI. To avoid the problem, power off HD OMNI before launching versions of Pro Tools lower than 8.1.
No Sound on Output after Hardware RESET (PTSW-126575)

After resetting the HD OMNI interface to the default factory settings using the front panel controls, the HD OMNI interface stops emitting sound in sessions where the outputs are not assigned to the Monitor output path. To correct this problem, press the ALT monitor button to switch to the ALT Monitor path, and then press it again to switch back to the Main Monitor path.

Loss of Monitor Path when Launching Pro Tools with HD OMNI Off or Disconnected (PTSW-127313)

When launching Pro Tools and opening I/O Setup after powering off HD OMNI or disconnecting it from the system, the inactive Monitor path is not present in Output tab. You may need to restore the default I/O Settings and remap the corresponding Output Busses.

Output Paths are not Automatically Created in the Output Page of the I/O Setup After Disabling the Corresponding Monitor Path in the Monitor Page of the Hardware Setup and Re-assigning the Outputs from “None” to Physical Outputs in the Main Page of the Hardware Setup (PTSW-127559)

After disabling the Monitor path in the Monitor page of the Hardware Setup and re-assigning the corresponding Outputs from “None” to physical outputs (such as “A 1-2”) in the Main Page of the Hardware Setup, these Output paths are not automatically created in the Output Page of the I/O Setup. You will have to manually create the appropriate Output paths in the I/O Setup (or click Default).

Changing Monitor Path Output Assignments in the Hardware Setup does not Update the Output Paths in the Output Page of the I/O Setup (PTSW-127563)

When changing Monitor path Output assignments in the Monitor page of the Hardware Setup (such as setting the Monitor path Format to None or assigning the Monitor to different physical outputs), the Output paths in the Output page of the I/O Setup do not reflect the corresponding changes. You will have to manually create the appropriate Output paths in the I/O Setup (or click Default).

When Creating New Sessions, Using the I/O Settings Selector Can Result in Unexpected Output Assignments if HD OMNI Has an Assigned Monitor Path (PTSW-123896)

If HD OMNI has an assigned Monitor path, Output paths created by the selected I/O Settings option in the New Session dialog may be offset by the channel width of the Monitor path. If this happens, you will have to manually create the appropriate Output paths in the I/O Setup (or click Default).

I/O Setup Bus Page Erroneously Adds Monitor Paths (PTSW-127739)

With both MAIN and ALT Monitor paths declared, toggling one of the CR Monitor paths from the current format to “None” and then back to the starting Monitor format from within the Hardware Setup Monitor page, causes the Bus page in I/O Setup to erroneously add an extra Monitor path with the abbreviation with “(1).” This can happen numerous time and each new Monitor abbreviation increments accordingly.

003 Family and 002 Series Interfaces

Reconnecting an 003 or 002 After Losing the Connection with Pro Tools (PTSW-20351)

If your 003 family or 002 series interface looses its connection with Pro Tools, increasing your buffer size or changing your CPU usage limit may bring the device back online without having to close Pro Tools or restart your computer.

Importing .PIM Files on an 003 System with a C|24 (PTSW-46401)

When importing a custom map .PIM file created on a 003 to another 003 system with a C|24, 003 displays “<No Tracks>“ on the scribble strips instead of staying in Plug-in Edit mode with a restored newly imported Plug-in Map. You will need to switch to another mode on 003 and then re-enter Plug-in Edit mode to correct this.
Pro Tools Aggregate I/O (Mac Built-In Audio)

–6101 Error When Previewing Audio with Pro Tools Aggregate I/O (PTSW-132996)

When previewing audio in the Import Audio dialog with Pro Tools Aggregate I/O selected as the Current Engine (in the Playback Engine dialog), and with the Mac OS File view is set to Columns view, you may encounter a –6101 error. Try changing the Mac OS file view from Columns to List or Icons view, or use any of the built-in audio devices instead of Pro Tools Aggregate I/O to avoid this problem.

Changing Sample Rates in Audio MIDI Setup can cause Aggregate I/O to Disappear in I/O Setup, Resulting no Audio Output (PTSW-132281)

When Pro Tools Aggregate I/O is selected as the Current Engine in the Playback Engine dialog, changing sample rates in Audio MIDI Setup can cause the Pro Tools Aggregate I/O to be removed from I/O Setup resulting in no audio output. To correct this problem, click the Default button on the Output page of the I/O Setup.

Error Messages When Opening a Session with a Different Sample Rate from the Aggregate I/O Sample Rate Setting (PTSW-131779)

Pro Tools may indicate that a given Aggregate I/O device has not automatically adjusted its sample rate when a session with a different sample rate is opened. You may subsequently be presented with a dialog indicating that the session needs to be closed and reopened to update the sample rate setting of the Aggregate I/O device.

Renaming Pro Tools Aggregate I/O driver in AMS Corrupts the Driver (PTSW-131383)

If you rename the Pro Tools Aggregate I/O driver in Audio MIDI Setup (AMS), the driver be corrupted the next time you launch Pro Tools. If this happens, quit Pro Tools and delete the Pro Tools Aggregate I/O device from AMS. Pro Tools will re-create the driver the next time it is launched.

Pro Tools Quits Unexpectedly when Enabling the Built-In Digital I/O (PTSW-132189)

When enabling built-in digital I/O for Pro Tools Aggregate I/O in Audio MIDI Setup, Pro Tools quits unexpectedly. To avoid this problem, enable the built-in digital I/O in Audio MIDI Setup before launching Pro Tools.

Third-Party Core Audio Devices

Pops and Clicks can Occur when Using Third-Party Core Audio Devices with Pro Tools (PTSW-132084)

Note that audible pops and clicks can occur when using some third-party audio interfaces even if Error Suppression is disabled. Try increasing the Hardware Buffer size for the device to avoid this problem.

Using Low Buffer Sizes with Studio Monitor Express may Result in Pro Tools Quitting Unexpectedly with a Loud Burst of Noise (PTSW-132513)

Using Studio Monitor Express with some Core Audio Devices may result in Pro Tools quitting unexpectedly along with loud bursts of noise. Studio Monitor Express is not recommend for use with Pro Tools at this time.
Error Messages

Error –6042
If you repeatedly encounter –6042 errors, open the System Usage window and check the PCI gauge. If the gauge is peaked, you will need to reset the PCI bus. To reset the PCI bus, make all tracks inactive and start playback. If you still encounter a –6042 error, quit and relaunch Pro Tools, open the Playback Engine dialog, and change the Number of Voices to a setting that uses fewer voices per DSP.

DAE Error –9073 Without Reaching the 2 GB File Limit
If you encounter a –9073 error, and you have not reached the 2 GB file size limit, please refer to the Knowledge Base for possible causes and solutions (www.avid.com/onlinesupport).

DAE Error –9128
In sessions with high sample rates (96 kHz or higher), you may need to set the Hardware Buffer Size to 512 or more to avoid –9128 errors during playback with RTAS plug-ins or dense automation.

DAE Error –9131 (92747, 20843)
GUID partitioned drives will not allow you to record beyond the third partition when running on OS X. A workaround is to partition audio drives using Apple Partition Map instead of GUID.

– or –

Recording to or playing from a UNIX File System (UFS) formatted drive is not supported in Pro Tools.

DAE Error –9132 (32397)
If a –9132 error occurs during Bounce To Disk (even with the highest Hardware Buffer setting selected), bus the appropriate tracks to the appropriate number and format of audio tracks, and record to disk. You can then use the resulting audio files as you would have used bounced files.

DAE Error –9155
In sessions with high sample rates of 96 kHz or more, you may need to set the Hardware Buffer Size to 512 or more to avoid –9155 errors during playback with dense automation.

DAE Error –9735
When Pro Tools reaches the end of its time limit in the session Timeline, or if Pro Tools has been in continuous play for longer than the maximum time limit, you will encounter a DAE error –9735. The maximum time limit for Pro Tools depends on the session sample rate. For more information, see the Pro Tools Reference Guide.